
Chapter 1
HMSL on the Macintosh

HMSL is a programming language for experimental music.  It is available on the Macintosh and 
Amiga computers.  The language is primarily host independant.  That means that it works pretty much 
the same way on both machines.  There are, however, some minor differences.  The Amiga version 
uses JForth to provide the Forth environment.  The Macintosh version uses its own Forth that is 
integrated with HMSL, called HForth.  The Macintosh version also uses the Apple MIDI Manager for 
its interface to MIDI so there are a few differences there as well.  This supplementary manual 
documents all the features of HMSL that are specific to the Macintosh.

What is HForth?
HForth is a 32 bit, subroutine threaded Forth written to support HMSL, the Hierarchical Music 
Specification Language.  HForth provides the general purpose programming environment needed by 
HMSL.  HForth has a compiler to convert your music programs to a form that the 68000 can 
understand and execute.  It also has a text editor, a debugger, an interactive text window and many 
other features.  It was developed by Phil Burk.

Requirements for running HMSL
To run HMSL, you must have the following:

1) A Macintosh with at least 1 Megabyte of memory.

2) Finder version 6.0.2 or later.

3) Two floppy disk drives, or one floppy and a hard disk.

4) A System folder with at least 100K free in it.

5) A MIDI Interface.

6) A MIDI Synthesizer.

7) A sound system, ie. amplifier, speakers, etc.

Installing HMSL
Even though you are anxious to start using HMSL but there are a few things that must be done first. 
These only have to be done before running HMSL for the first time.  The procedure will differ slightly 
depending on whether you will be running HMSL from floppies or a hard disk.

Backing Up HMSL

1) Make backup copies of both HMSL disks.  Save the original disks in a safe place.  Use the new 
copies as your working disks.  It is important that you name the copies the same as the original 
disks.  The original disks are named "HMSL_Source" and "HMSL_User."

2) If your system disk is a floppy, you should also make a backup copy of your system disk.  Then 
reboot using the new copy of the System disk.

Installing HMSL on a hard disk

If you do not have a hard disk, or do not want to install HMSL on your hard disk, then skip this 
section.
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1) Make a folder for HMSL on your hard disk called "HMSL".

2) Insert HMSL_User into a floppy drive and double click on its icon.  Select all of the folders in the 
HMSL_User window and drag them to the HMSL folder on your hard disk.

3) Do the same as (2) for HMSL_Source.  If you are short of space on your hard disk, you might want 
to only install the folder "Source" from the HMSL_Source disk.

Installing the Apple MIDI Manager.

HMSL uses the Apple MIDI Manager to interface with the serial ports.  This allows different MIDI 
applications to run under MultiFinder.

1) You may already have the MIDI manager installed on your Macintosh.  Double click on your 
System disk icon and find the System folder. Look for the files "MIDI Manager" and "Apple MIDI 
Driver".  Check the version number of these files by selecting them, then select the "Get Info..." 
item from the "Files" menu.    Do the same for the copies of the MIDI Manager supplied with 
HMSL.  These will either be on their own disk or on the HMSL_User disk if space permits.  If the 
version you have matches or is later than the version supplied with HMSL, then skip the rest of this 
procedure.

2) Warning:  Old versions of the MIDI Manager had a slightly different name than the new version. 
Old versions had a ™ at the end. If you just put the new version in your system folder, it may not 
replace the old version.  You could have two versions with slightly different names.  This could 
cause a hard disk crash.  (You're right.  This is ridiculous. Tell it to Apple). If you have a version of 
MIDI Manager older than the one on the HMSL disk then you must remove "MIDI Manager™" 
and "Apple Midi Driver" from the system folder before installing the new version.

3) Copy the files "MIDI Manager" and the "Apple MIDI Driver" into the System folder.  If you have 
plenty of room on your system disk, you can also copy the "Patchbay Help" file to the System 
folder.

4) The MIDI manager will not be available until you "Restart" your Macintosh.

Installing the PatchBay Desk Accessory

Now we must install the Patchbay Desk Accessory in your system. The Patchbay is a MIDI Manager 
tool that allows you to connect different MIDI applications together.  It is very important when using 
HMSL.  It is possible that the Desk Accessory may not work on your system.  If it doesn't, use the 
PatchBay Application instead . (See the MIDI Manager chapter for more information.)

System 6 Users

1) The Font D/A Mover is an Apple supplied program that comes on one of your System Utilities disk. 
Find the program and double click on it.

2) Select "Desk Accessories" instead of "Fonts" at the top of the window.

3) Click on "Open" near the lower right corner of the window.  Find and open the "MIDI Manager " 
folder and find the file called "PatchbayDA" on the HMSL_User disk.

4) Select  "PatchBay"  from the right hand column.  (There may be some extra D/As which will be 
described in the release notes. Hold down the SHIFT key when you want to select more then one 
item.)  Copy it to the left hand column which is your system disk.  If there is not room, you will 
have to remove some Fonts or D/As from the System disk.  That is why we made a backup of the 
System disk.  You may want to keep a special system disk just for HMSL. Quit from the Font D/A 
Mover when done.

5) Activate the MIDI Manager and your Desk Accessories by restarting your Macintosh.  This can be 
done by selecting "Restart" from the "Options" menu.

System 7 Users
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Open the MIDI Manager folder.  Move the PatchBay Desk Accessory to the Desk Accessory folder on 
your system disk.

IMPORTANT - Setting the ASSIGNS for your Hard Disk (logical volume names)

If you installed HMSL on your hard disk, please follow these instructions.

HMSL uses logical volume names for folders.  This allows programs to reference folders using "nick 
names."  This allows us to hide the fact that actual folder may have different names on different 
people's hard disks.  We can reference the Pieces folder using the logical volume name HP: which 
might translate to "HMSL_USER:PIECES:" on one person's system, or 
"HARDDISK:HMSL:PIECES" on another's.  It also saves a lot of typing.

In this procedure, we will edit the ASSIGNS file to make it compatible with your system.  Then we 
will load these new assignments into HMSL and save a new version of HMSL with those assignments. 
In essence, we will teach HMSL where to find its files on your system.

1) It is important that the name of your hard disk not have any spaces in it because Forth uses spaces to 
separate names.  If it has spaces in the name, please change it.  Most computer operating systems 
do not encourage spaces in names because they make it complicated to use command line 
interfaces.  For example, if your hard disk is named "Big Disk", you might rename it "Big_Disk." 
Also be careful there are no spaces at the end of the names.  These are hard to spot.

2) Open the HMSL folder on your hard disk and double click on the HMSL4th_V4.x icon.

3)  Wait for it to load.  When asked whether to initialize, enter 'N' for "No."

4) Edit the file ASSIGNS using the HMSL Text Editor.  Select "Open..." from the File menu.  Open the 
file called ASSIGNS in your HMSL folder.

5) Remove the backslashes, '\', from in front of the definitions of HMSL_USER: and 
HMSL_SOURCE:.  We will change them so that HMSL will look on your hard disk for files 
instead of the original disks.  If your hard disk is called "20MHD,"  define them as follows:
ASSIGN  HMSL_User:  20MHD:HMSL
ASSIGN  HMSL_Source:  20MHD:HMSL

If, for example, you have a hard disk called "Stuff," that contains a folder called "Music," that contains a 
folder called HMSL_V4, then you should define them as:

ASSIGN  HMSL_User:  Stuff:Music:HMSL_V4
ASSIGN  HMSL_Source:  Stuff:Music:HMSL_V4

Whenever HMSL is given a file name that begins with an assigned name, it will substitute the real name. 
Notice that later in the file is the line:

ASSIGN  HP:  HMSL_User:Pieces

Based on the first assignment from above, this is the equivalent of saying:
ASSIGN  HP:  20MHD:HMSL:Pieces

Now if you refer to a file as HP:XFORMS, that will be the equivalent of saying 
20HMD:HMSL:Pieces:XFORMS. For more information on this, refer to the section on File I/O later in 
this manual.

6) Save the file to disk by selecting "Save" from the File menu.

7) Include the ASSIGNS file by selecting "Include from Editor" from the "Include" menu.  You can 
check your assignments by entering:
ASSIGNS
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8) HMSL has two timers, a highly accurate interrupt driven timer, and a crude software based timer for 
non-critical use.  To calibrate this second timer, enter:
CALIBRATE.MSEC

9) To save these changes, enter:
SAVE-FORTH   BYE

Your assignments will now be remembered for future sessions.  There is more information on ASSIGN 
with the File I/O documentation.

Running HMSL

Follow this procedure whenever you want to run HMSL.

1) Floppy users: Open the HMSL_User disk.

--OR--

Hard disk users: Open the HMSL icon on your hard disk.

2) Double click on the HMSL4th_V4.x icon.

3)  Wait for it to load.  When asked whether to initialize, enter 'y' for "yes."

HMSL should then initialize and print several messages ending with "ok."  If it cannot open the MIDI 
Manager, double check your installation, then see the trouble shooting instructions below.

Testing MIDI Output

1) Connect the Phone port of your Macintosh to a MIDI Interface.  Then connect the output of your 
MIDI Interface to the "MIDI In" port on a synthesizer.

2) Setup the synthesizer so that it will receive MIDI messages on channel 1.  Consult the owners 
manual for your synthesizer for specific instructions if needed.  Connect your synthesizer to an 
audio amplifier and speakers.  Verify that sounds can be heard by playing the keyboard if it has one.

3) Click on the HMSL4th window and hit the <RETURN> key several times.  You should see "ok" 
messages from the Forth telling you it is ready for command input.

4) Enter in HMSL4th:
MIDI.TEST

You should see a message telling you it is sending Middle C notes.  You should also be hearing about two 
notes per second.  If you hear nothing proceed to the next section on Troubleshooting MIDI. Hit the 
<RETURN> key when done.

5) To test MIDI input, connect a keyboard or other controller to your Mac's MIDI input. Then enter:
MIDI.SCOPE

Now play the keyboard,  you should see MIDI events displayed on the screen as you play.

When MIDI is working properly, refer to the main HMSL manual for instructions on how to learn 
HMSL.  It will occasionally refer you back to this book for Macintosh specific instructions.

Troubleshooting MIDI
Symptom: Error message when initializing HMSL saying that the MIDI Manager could not open a 
driver.

Fix: Try switching from using the old Finder to using MultiFinder, or vice versa . This can be done by 
selecting "Set Startup..." from the ????? menu.

The MIDI Manager can also have a problem if you have too many INITs in your System folder.  If you 
still have problems, move all of your custom INITs to a folder outside of your System folder and 
reboot.  Test MIDI.  If it works, start moving INITs back into your system folder and rebooting until 
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MIDI does not work.  Some INITs may interfere directly with the MIDI manager.  If you find that the 
MIDI Manager does not work with a specific INIT, please call Phil Burk at Frog Peak Music. We can 
then warn other users and inform Apple.  You may also try using the Custom MIDI Driver.

Symptom: No error message on initialization, but no output.

Fix: There seems to be a bug with the Apple CHOOSER Desk Accessory that causes the MIDI 
Manager to sometimes think the phone port is busy when it isn't.  This is prety rare.  If MIDI Output 
doesn't work on the serial port, open the Patchbay desk accessory.  Double click on the Apple MIDI 
Driver icon on the left.  Try to enable the Phone Port MIDI.  If you cannot enable MIDI on the phone 
port, enter in HMSL:

MIDI.FIX.SPCONFIG

This will reset the phone port bit in the SPConfig global variable.  Now run Chooser before starting 
MIDI which will copy this fix to permanent RAM.

Compiling Programs
Very short programs can be entered directly using the keyboard.  For longer programs, you can use the 
HMSL Text editor to write the programs and save them in a file.  To run your program, you must first 
compile it.  You can compile the program from the file, using one of 4 ways.

1) From the Include menu.  The first item in the Include menu is "Include File..."  Selecting this will 
bring up the standard file requester.  Select the file you want to compile.

2) Type INCLUDE filename.   You can compile from the keyboard by typing INCLUDE followed by 
the name of the file to compile.  You can use assigned logical volume names to avoid having to 
type complete pathnames.  See the File I/O section in this manual for more information on 
ASSIGN.
INCLUDE HP:SUBDIV

3) ReInclude a file by selecting the "ReInclude item" from the Include menu.  This will include 
whatever file was last included.  This is handy if you are working on a file and compiling it over 
and over again.

4) When you are editing a file using the HMSL Text Editor, you can include the code directly using the 
"Include from Editor" menu item.

Compilation Errors

If the Forth compiler encounters a word that it doesn't recognize, it will print that word followed by a 
'?' then abort.  Look in the file for the unrecognized word and fix it.  Save it then recompile using the 
ReInclude menu item.  If you are not sure where the error occurred, enter:

LATEST   ID.

This will tell you the name of the last word defined.  Your error will be in that word or right after it.

Editing Programs

HMSL has its own integrated text editor.  It can be accessed using "New" and "Open..." from the File 
menu. It behaves like other Macintosh style text editors so you should have no trouble figuring it out. 
It does, however, have a few unique features.

1) You can compile code directly from the file using the "Include from File" menu item.  If an error is 
encountered, the file editing window will be brought to the front and the offending text will be 
highlighted.

2) If you select a region, and hit the <Enter> key, that region will be compiled and the output directed 
to the Forth window.
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3) If you place the cursor on a line and hit <Enter>, that line will be executed.  The output will be 
directed to the editor.  This is a handy way to get Forth output into the editor.  Note that the contents 
of the stack will not be preserved between successive entries.

4) Characters can be converted between UPPER case, lower case, and Capitals.

5) The "Windows" menu allows you to select various windows.  You can open multiple windows and 
select between them using this menu.

Expanding the Dictionary
HForth allows you to expand your dictionary if you run out of room.  There are two variables that 
control how large an area of memory to allocate when HMSL starts up.  One specifies the code 
dictionary size.  The other specifies the header/name space.  You expand the dictionary by setting these 
variables to large values then saving the Forth image. If you are working and find you have run out of 
space, you should quit from HMSL and follow these steps.

1) If you want the larger image to have a different name than the older small one, make a duplicate and 
rename it.  You do this by selecting the HMSL4th icon then selecting "Duplicate" from the File 
menu.  The HMSL4th icon may have any name.

2) Run HMSL4th.  It is important to start fresh, so you should quit and restart if you have been using 
HMSL or working on other projects.

3) Do not initialize HMSL or any other complicated systems.  Hit 'N' when it asks if you want to 
initialize. You should not allocate any memory, or open any files or device drivers (eg. MIDI).

4) Check the values of the two size control variables.  Enter:
CODE-SIZE @ .
HEADERS-SIZE @ .

Or enter:
MAP

which prints statistics about the Forth memory usage.  These values are in bytes.  Set them to values that 
you think will allow you to fit your programs.  If you set them too large, you will run out of memory on 
your machine.  You should set the HEADERS-SIZE to roughly half of the CODE-SIZE.  For example, 
enter:

300000  CODE-SIZE  !
140000  HEADERS-SIZE  !

5) Now save the Forth image to disk using SAVE-FORTH.  Then quit from this image and restart it to 
get the larger image.  Enter:
SAVE-FORTH    BYE

6)  When you get back to Finder, double click on the HForth icon you just saved.  This will load your 
expanded dictionary.
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